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Overview 
Microsoft PowerPoint 2013 is a presentation application that enables an individual from any technical level 
to create a dynamic and professional-looking presentation. This is a hands-on workshop to help University 
of Pittsburgh faculty and staff with the fundamental features of PowerPoint and will teach them how to 
develop a slide presentation that will engage and inform an audience. Topics covered include: 

• Learn about the new Ribbon interface in PowerPoint 2013 
• Learn how to create slides, use Themes, and apply color schemes  
• Master how to format text, colors, and bullets  
• Create maximum impact slides by inserting and editing pictures in your slides  
• Learn how to include transition and animation effects 
• Organize and manage your slides using PowerPoint’s View options 
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I. Introduction 
 
Microsoft PowerPoint is a robust application that allows you to combine text, graphics, and 
predesigned backgrounds to create professional presentations. The following is an illustration in 
how to launch PowerPoint for the first time user.   
 
 
A. Launch Microsoft PowerPoint 2013 
 
To launch PowerPoint for the first time: 
 
1. Click on the Start button. 

 

 

 

 

 

 

2. Click on All Programs, select Microsoft Office from the menu options, and then click on 
Microsoft PowerPoint 2013. 

 
 
 
 
 

  Note: After PowerPoint has been launched for the first time, the PowerPoint        icon will be 
located on the Quick Launch pane. This enables you to just click on the Start button and then 
click on the PowerPoint icon to launch PowerPoint. Also, a shortcut for PowerPoint can be 
created on your desktop. 
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B. Windows Features 
 
The purpose of Windows Features is to enable the user to perform routine tasks related to the 
Microsoft applications. All Office applications share a common appearance and similar features. 
Windows Features provide a quick means to execute commands. Below are some pertinent 
PowerPoint features: 
 
 
 
 
 
 

 
 

 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Status Bar 

9. Collapse 

11. View Options 
   

6. Subtitle Placeholder 

5. Title Placeholder 

4. Thumbnail Slide 

3. File Tab 

1. Quick Access Toolbar 2. Title Bar 

8. Ribbon 

10. Work Area 
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C. Feature Terms and Descriptions 
 
 

 Term Description 

1 Quick Access Toolbar Displays quick access to commonly used commands. 

2 Title Bar Displays the name of the open file. 

3 File Tab The File tab has replaced the Office 2007 button. It helps you to manage 
the Microsoft application and provides access to options such as Open, 
New, Save As, Print, etc. 

4 Thumbnail Slide Displays a snapshot of each slide.  

5 Title Placeholder Section where text is entered. 

6 Subtitle Placeholder Section where text and/or graphics are entered. 

7 Status Bar Displays information about the slide presentation, such as page numbers. 

8 Ribbon Displays groups of related commands within tabs. Each tab provides 
buttons for commands. 

9 Collapse Collapses the ribbon so only the tab names show. 

10 Work Area Each slide has an area where text and graphics are entered for a 
presentation. There are various slide layouts to work from. 

11 View Option Displays several View modes for slides. 
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D. Presentation Slides 
 
Slides in a presentation are similar to pages in a word processing document. All slides and graphics 
are saved in one file (example: keys.xppt). Use the PowerPoint file to present the information in 
the following ways: 
 
 
 
 
 
 

 
 
 
 
 
• On-screen slide show: The keys.xppt file displays the slide show on a monitor or computer-

projected large screen. 

• Web pages: The keys.xppt file can be saved as Web page and then published on the Web. 

• Overhead transparencies: The keys.xppt file can be printed as transparencies (Important: 
Make sure the appropriate transparencies are used for your printer model. The wrong type of 
transparencies can melt inside your printer.).  

• Handouts: The keys.xppt file can print two to nine mini slides per page. 
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II. Create Slide Presentation 
 
 
This section will teach the basics of opening PowerPoint and beginning a presentation. 
When PowerPoint is launched the Presentation window will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

When creating a new presentation, you have choices about how to proceed. PowerPoint gives you 
a range of ways with which to start creating a presentation. You can start your presentation with: 

• Blank: Slides that are unformatted and have no color scheme.  
• Design: Slide Themes that have design concepts, fonts, and color schemes.  
• Template on Microsoft.com: Microsoft Office Templates and Theme Gallery which are 

arranged according to type (Click on the File tab, select the New option, and then click on 
PowerPoint presentations and slides from the Available Templates and Themes.).  

 
 
This workshop section will focus on using a Design Theme. 
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A. Design Theme 
 
A Theme gives your slides a consistent appearance throughout your presentation. Themes contain 
color schemes with custom formatting, styled fonts, and layouts. When you apply a design 
template to your presentation, the slide master and color scheme of the template replaces the 
original blank slide.   

 
1. Select the Design tab, then on the Theme group, click on the drop-down arrow next to the 

last Theme. 

2. The All Themes window will appear with available presentation Themes. 

 

 

 

 

 

 

 

 

 

3. Hover the mouse pointer over a Theme to preview it.  

4. Click on a Theme of your choice. 

  

Note: You can change the Theme during or after the creation of your PowerPoint file. 
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B. Add Text 

The template for the design Theme you select will determine the font type and text alignment. 
PowerPoint places all information (text and graphics) contained on a slide in separate 
Placeholders. Placeholders are designated by dotted lines; they appear on a slide as guides, but 
they will not appear on the finished presentation. In order to edit text, click once inside of the Text 
Placeholder and the insertion point will appear; then begin to type your text.   
 
 
 
 
 
 
 
 
 
 
 
 
 
1. Click in the Title Placeholder and type the text title below. 

 
 
 
 
 
 
 

 

2. Click in the Subtitle Placeholder.  

3. Type the text below (You will need to press the Enter key after each line of text.). 

 

 

 

 

 

4. Save the presentation. Click on the File tab and then click on Save As. The Save As 
window will open. In the File name box, type Keys to Success for the presentation name. 
The instructor will indicate where to save the file. Click on the Save button. 
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C. Add New Slide 
 
A slide layout defines the placement of text, pictures, tables, and graphs. If you change the layout 
of a slide, the text and graphics remain intact. You can resize text and graphic boxes to conform to 
the new layout. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1. On the Home ribbon, located in the Slides group, click on the New Slide drop-down arrow. 

The Office Theme panel will appear with multiple slide layouts. Select your desired slide 
layout.   

2. For this exercise, click on the second Layout (Title and Content) in the first row. 

 

 

 

 

 

 

 

 

3. In the Title Placeholder, type the text Agenda as seen above. 

4. In the Text Placeholder, type the bulleted text as seen above (You will need to press Enter 
after each line of text.). 

5. Add another new slide.   
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6. On the Home ribbon, click on the New Slide drop-down arrow and then select the Two 
Content slide layout (This slide contains a title, text, and clip art placeholders.). 

 

 

 

 

 

 

 

 

7. Click inside the Title and Text Placeholders and type the text shown above. 

 

 

  

8. On the Quick Access Toolbar, click on the Save button to save your presentation changes. 

 

 

 



File: Microsoft PowerPoint 2010 Fundamentals                                Page 13 of 43 October 10, 2013 
 

III. Editing Techniques 
 
This section will teach you basic techniques for editing slides. 
 
A. View Modes for Editing 
 
The Normal, Slide Sorter, Reading, and Slide Show Views allow you to type, edit, and view 
your presentation. To switch between views, click the View Options                              buttons at 
the lower right-hand side of the PowerPoint window. 
 

Normal View 

Normal View is the main editing View, which you use to 
write and design your presentation. The View has three 
working areas: on the left, tabs that alternate between an 
outline of your slide text (Outline tab), and your slides 
displayed as thumbnails (Slides tab); on the right, the 
slide pane, which displays a large view of the current 
slide; and on the bottom, the notes pane. 

Slide Sorter View 
 

Slide Sorter View is an exclusive view of your slides in 
thumbnail form. When you are finished creating and 
editing your presentation, Slide Sorter gives you an 
overall picture of it — making it easy to reorder, add, or 
delete slides, and preview your transition and animation 
effects. 

Reading View 
 
 Reading View is new in PowerPoint 2013. It is similar to 

Slide Show View. The difference between the two Views 
is that while Slide Show View takes over the whole 
screen, the slide in Reading View is shown in full screen, 
but you will see the PowerPoint title band at the top of 
the screen. The PowerPoint status bar and the Windows 
task bar are also displayed at the bottom of the screen. 

Slide Show View  
Slide Show View takes up the full computer screen, like 
an actual slide show presentation. In this full-screen 
View, you see your presentation the way your audience 
will. You can see how your graphics, timings, movies, 
transition effects, and animation elements will look in the 
actual show. 
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B. Edit Bulleted List 
 
Typing text in PowerPoint is similar to typing in other applications. However, since PowerPoint 
deals with bulleted lists, a few keystrokes will be identified to help in typing multiple lines. 
 
 
1. Confirm you are on slide three. 
 

 

 

 

 

 

 

 

2. In Normal View, edit the bulleted list to include the circled text above. Place the Insertion  
 bar after each line of the bulleted text and then press the Enter key. 
 

 

 

 

 

3. To add a sub-bullet, click on the Increase Indent button, located on the Home ribbon.  
 The Tab key can also be used to indent text.   
 
4. Type the text and if additional sub-bullets lines are needed press the Enter key, after your  
 line of text. 
 

Note: Pressing Enter after any text returns the cursor to the same indent (paragraph) level for the 
next line. The Tab key is also used before typing to indent text to the next indent level (sub-bullet 
point) and pressing Shift+Tab before typing to return to the previous indent level. 
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C. Add Pictures 
 
 
Online Pictures are any type of computerized images such as artwork and photos. You can make 
your presentation more eye-catching and entertaining by adding Pictures. 
 

1. Confirm you are on slide three. 
 
 
 
 
 
 
 
 
2. Click on the Online Picture button in the Illustration box, located in the Text  
 Placeholder. 
 
3. The Bing Image Search window will appear. 
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4. In the Search box, type the word Classroom, and then press the Enter key.  
 A variety of online images associated with your search will appear. 
 
5. Scroll through the Pictures window to find your desired image.  
 
6. To insert the image, place the mouse pointer on the image and then click on the left mouse  
 button twice. 
 

 

Note: When the Illustration box does not appear on a slide, images can still be inserted by 
selecting the Insert ribbon and then click on the Online Pictures button. 
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IV. Slide Masters 
 
PowerPoint has a set of Master Slides available for every Design Theme. The three Masters 
include a Slide Master, Handout Master, and Notes Master. Masters correspond directly to the 
slides. Masters contain the elements that appear on every slide and control the format for all slides 
in a presentation, which provides a consistent appearance for each slide. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A. Edit Slide Master 
 
The Slide Master View is located on the View ribbon. This exercise will demonstrate how to 
modify a Slide Master which will affect your entire presentation.  
 
 
 
1. Change to Slide Master View by selecting the View ribbon. Click on the Slide Master 

button, located in the Master View group as shown above. 
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2. Click on the Master Title Style placeholder border. This will activate the entire title area. 

 

 

 

 

 

3. Select the Home tab and then click on the Font show dialog box. 

4. The Font window will appear. 

 

 

 

 

 

 

 

 

5. Confirm that the Font tab is active. 

6. In the Latin text font box, change to a different Font type. 

7. In the Font color box, change to a different color. 

8. Click on the OK button.    
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9. Select the View ribbon tab and then click on the Normal button in the Presentation Views 
group. 

10. Scroll through the slides to see how the font and color changes made in the Slide Master 
have affected the entire presentation. 

 
 
Note: Changes you make to the Slide Master will affect all slides in your presentation. 
 
 
 

 
V. Format Slide 
 
You can change the format appearance of text and slides in the Slide View as well. Formatting can 
be applied to all slides at the same time as in the Master View or only on an individual slide.   
 
 
A. Replace Font 
 
Use the Replace command to change the font throughout a presentation. 
 
 
 
 
 
 
 
1. Go to slide two. 

2. Click on the Text Placeholder (bulleted list) border.   

3. On the Home ribbon, click on the drop-down arrow next to the Replace button, located in 
the Editing group, and then select the Replace Font option.  

4. The Replace Font window will appear.  
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5. In the Replace box, click on the drop-down arrow and select the Font you want to replace.  

6. In the With box, click on the drop-down arrow and select the desired Font.  

7. Click on the Replace button to change all slides. 

8. Click on the Close button.  

9. View your change. 

 

B. Format Text 
 
Text appears on each slide in a format consistent with the template. You can add or change any 
text attribute such as bold or italics on any given slide by making the change on the slide. The 
Font button commands are located on the Home ribbon in the Font group. 
 
 

 
 

 
 
 

 
 

 
 
1. Go to slide one. 

2. Select the Title Placeholder, and click on the Italic       button in the Font group. 

3. Use the Font Size   button to change the point size to a higher number. 

4. Go to the next slide. Notice that the title text on this slide has not been affected. 

 

 

 

5. Go to slide two, click on the Font Color       button, located in the Font group, to select a 
different color.  
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C. Format Placeholder 
 
You can resize or add color and lines to a placeholder, as well as changing the text to a different 
style and color. 
 
 
 
 
 
 
 
 
 
1. On slide two, select the Text Placeholder. 

2. On the Drawing Tools ribbon, click on the Format tab. View the different formatting 
options within the groups. 

3. In this exercise the instructor will guide you through several formatting options for your 
placeholder. 

 

D. Change Bullets 
 
PowerPoint allows you to change the style, color, and size of bullets. You can apply the new bullet 
style to a single bullet, a bulleted list, or for an entire presentation. To change a single bullet, click 
the cursor anywhere in the line corresponding to the desired bullet. To change multiple 
bullets/lines, use the mouse to select the bulleted items you want to change, or select the Text 
Placeholder to change all bullets within the placeholder.  
 
 
1. Go to slide three. 

 

 

 

 

 

 

2. Click anywhere in the first line of Computer-base training (CBT). 
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3. Select the Home tab, click on the drop-drop arrow next to the Bullets button.  

4. The Bullets panel will appear and then you have the option to select one of the bullet styles 
that appear. 

5. More bullet options are available by clicking on the Bullets and Numbering option, 
located at the bottom right-hand side of the window (On the Bullets and Numbering 
window, you have Bulleted and Numbered tab choices.). 

6. The Picture and Customize buttons will appear on the bottom of the Bullets and 
Numbering window.  

 

 

 

 

 

 

 

 

 

7. Clicking on the Picture button provides an array of picture bullets to select. Clicking on 
the Customize button will allow you to choose a variety of Symbol windows with each 
window having multiple symbols to select as bullet options. 

8. In this exercise you will select a square-shaped bullet style and then click OK.  

 
Note: To select a different color for bullets, use the Color drop-down list on the bottom of the 
Bullets and Numbering window. The size of the bullet can be increased or decreased as well. 
Click the up or down arrows next to the Size box to select a new bullet size.  
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9. Notice the bullet changed only on line one. 

 

 

 

 

 

10. Change the bullet style for the remaining lines of text by selecting the desired indented 
lines of text.  

11. Select the Home tab, click on the drop-drop arrow next to the Bullet button.  

12. The Bullet panel will appear.  

13. Click on a different bullet style or the same style on line one. 

 
 
E. Change Theme  
 
You have the option to change the slide Theme on one slide or an entire presentation. Hovering the 
mouse pointer over the Theme will allow you the options of Apply to All Slides or Apply to 
Selected Slide.  
 
 
 
 
 
 
 
 
1. Change the slide Theme to your presentation. Select the Design ribbon and then click on 

the drop-down arrow on the right-hand side of the last Theme thumb print row. More 
Themes will be previewed; select your desired Theme. 
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F. Modify Theme  
 
You have the option to change the Theme color, font, and background on your slides. Use the 
Design ribbon to modify your presentation Theme.  
 

1. To change your slide Theme color scheme, click on the drop-down arrow next to the Color 
button, located in the Themes group, and then select your desired color scheme.  

2. To change your slide Font, click on the drop-down arrow next to the Fonts button, located 
in the Themes group, and then select your desired Font options. 

3. To change your slide Background Color, click on the drop-down arrow next to the 
Background Style button, located in the Background group, and then select your desired 
background categories.  
(To remove a slide background graphic, select the Hide Background Graphics box.) 

 

 

G. Add Footer 
 
To insert information in the slide Footer, select the Header and Footer button located on the 
Insert ribbon. Information such as the date and time, the slide number, and desired text can be 
inserted on the Footer of the slides.   

 
 
 
 
 
 
 
 

 
 
1. Select the Insert ribbon tab and then click on the Header and Footer button. 
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2. The Header and Footer window will appear. 

 

 

 

 

 

 

 

 

 

3. Confirm that the Slide tab is active. 

4. Select the Date and time box. 

5. Select the Fixed button and then type today’s date in the Fixed entry box.   

6. Select the Footer box and then type University of Pittsburgh in the Footer entry box. 

7. Click on the Apply to All button. This will enable all slides to have the new information. 

 
 
Note: Once you select Date and time, you must select either the Update automatically or 
Fixed box.   
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VI. Transition and Animation 
 
PowerPoint allows you to apply special effects by using slide transition and text/graphical 
animation to make your presentation more visually appealing. 
 
 
A. Slide Transition 
 
Transitions are visual special effects that you see when you move from one slide to the next. 
Working in Normal or Slide Sorter Views allow you to set transitions for a slide. The Transition 
ribbon allows you to apply slide transitions. 
 
 
 
 

 
 

  
 
1. Go to slide one. 

2. Click on the Transition tab and then click on the drop-down arrow located in the 
Transition to This Slide group to view the transition categories as seen below. 
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3. In the Exciting selection, click on the Blinds button. The selected slide will demonstrate 
this effect as you make your choice. Click on the Preview button located on the Transition 
ribbon to demo the effect again. 

4. To apply your selection to all slides, click on the Apply to All button, located in the 
Timing group.   

5. Notice the transition indicator icon on the left-hand side of the thumb print slide in 
Normal View.  

 

Note: You can also apply sound and timing speed to the selected transition from the Timing group 
located on the Transition ribbon. Click on the drop-down arrow in the Sound box to choose a 
sound. Click on the up or down arrow in the Duration box to set the timing on the transition. 
 
 
 
 
 
 
 
 
B. Text Animation 
 
Bulleted text animation refers to the progressive display of bulleted items. Bulleted items, by 
default, appear at the same time on a slide. When text animation is applied, bulleted list items can 
appear on the slide one at a time or can have motion as they display on the screen. Select the 
Animation ribbon to apply animation to slide text. 
 
 
 
 
 
 
 
 
1. Confirm that you are in Normal View (View, Normal). 

2. Go to slide two. 

3. Click inside the Text Placeholder and select the text area. 

4. Click on the Animation tab and then click on the drop-down arrow located in the 
Animation group to view the animation categories as seen above. 

 



File: Microsoft PowerPoint 2010 Fundamentals                                Page 28 of 43 October 10, 2013 
 

 

 

 

 

 

 

 

 

 

 

5. In the Entrance section, click on the Fade button. 

6. Notice the animation indicator icon on the left-hand side of the thumb print slide in 
Normal View. 

7. Go to slide five, and select the Title Placeholder. 

8. Click on the Animation tab and then click on the drop-down arrow located in the 
Animation group to view the animation categories. 

9. In the Entrance section, click on an animation of your choice. 

 

 

Note: You can apply timing to or delay the speed of the selected animation from the Timing group 
located on the Animation ribbon. Click on the up or down arrow in the Duration or Delay box to 
set the timing or delay on the transition. 
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VII. Slide Illustrations and Shapes 
 
 
A. Illustration Features  
 
Microsoft Office has multiple Illustration and Image features to enhance your document with 
numerous graphics, sound, and motion. PowerPoint allows you to insert Illustration and Image 
features such as Tables, Charts, SmartArt, Pictures, and Media Clips within the Text Placeholders. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1. Click on an Illustration and Image button to locate, format, and insert features into your 

slide (These features can also be located on the Insert ribbon.). 
 
2. The SmartArt is the newest feature in Microsoft Office. When you click on the  
 SmartArt         button, the Choose a SmartArt Graphic window will appear. You can  
 enhance your slide presentation by incorporating text with a variety of images. 
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3. Go to slide three and then add a new Title and Content slide. 
 
4. In this exercise the instructor will guide you through the use of SmartArt and several other 

 Illustration features. 
 
 
 
B. Create Shapes 
 
SmartArt has numerous graphical options to select from, but you can also create your own 
graphical slide by using Shapes. Select the Insert ribbon to view available shapes.  
 
 

 

 

 

 

 

 

 

 

 

 

 

 

1. Confirm slide four is selected and then add a new Blank Layout slide. 

2. The instructor will guide you through this exercise in creating shapes on the new slide that 
is illustrated on the next page. 
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VIII. Slide Show  
 
Once you are finished adding text, graphics, and formatting to a presentation, then you can run the 
Slide Show. PowerPoint allows you to preview, rehearse, or show your presentation electronically 
to an audience. Display the presentation on-screen by selecting the Slide Show ribbon.  
 
 
A. Launch Slide Show 
 
1. Select the Slide Show ribbon and then click on the From Beginning button. The Slide  
 Show will begin with the first slide. 
 
 
 
 
 
 
 
 
Note: The Slide Show button  on the Option Views bar will start the slide show beginning with 
the current slide. 
 
 
B. Navigation Slide Show 
 
When running your slide show, advance to the next slide by clicking with your mouse, pressing the 
right arrow on the keyboard, or pressing the Enter key. To return to the previous slide, press the 
left arrow on the keyboard. To end the presentation, press the Esc key on the keyboard. 
 
You can use the following keyboard and mouse controls while running a slide show. Press the F1 
key during a presentation to display the dialog box below. 
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1. Navigate through the Slide Show by using some of the keyboard and mouse controls. 
 

2. Right-click with your mouse during the Slide Show and the menu below will appear; 
 you can also use this to navigate through your slide show. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: If you select Pointer Options, a pen icon will appear. You may then draw on a slide 
during the presentation. The drawing that the pen creates will be erased as soon as the next slide 
is displayed or you press the letter E on the keyboard to erase the drawing.   
To return to the mouse pointer again, right-click, choose Pointer Options, and then click on the 
Arrow option. 
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IX. Print Presentation 
 
Use the File tab and Print option to print your presentation in slides, outlines, speaker’s notes, and 
audience handouts. Slides will be printed in full color (on a color printer) or in grayscale (on a 
black and white printer). A PowerPoint presentation can also be printed on transparencies 
(Important: Make sure the appropriate transparencies are used for your printer model. The wrong 
type of transparencies can melt inside your printer.).  

    
 
 
A. Print  
 
1. Click on the File tab and then select the Print option.   

2. The print Settings and Preview screen will appear. 

3. In the Print All Slides area, you have the option to print all slides or determine which 
slides to print.  

4. After selecting your print Settings, click on the Print button. 
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B. Sample Output 
 
1. Presentation Outline  
 
In the Full Page Slides section, select the Outline option. Your presentation outline will preview 
before you print. Notice that graphics don’t display on the outline. 
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2. Presentation Speaker’s Notes 
 
In the Full Page Slides section, select the Notes Pages option. Your speaker’s notes will preview 
before you print. 
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3. Presentation Audience Handout 
 
In the Full Page Slides section, select the number of slides per page (3 Slides) option. You can 
select from one to nine slides per page. The slides per page will preview before you print. Three 
slides per page will place lines on the right-hand side of the slide. This is for audience notes. 
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X. Exit PowerPoint 2013 
 
To exit PowerPoint, select File and click on Exit or click on the close      button in the upper right-
hand corner of your document. If you have made changes to your document and not saved them, 
then the Microsoft PowerPoint window will appear. 
 
 
 
 
 
 
 
 
 
 
 

 
1. Click on the Save button to save any changes you made, click on the Don’t Save 

button to abandon changes, or click on the Cancel button which will allow you to return to  
your presentation work area. 

 
 
 
 
XI. Individual Exercise 
 
Based on what you have learned from this workshop, create your own PowerPoint presentation, on 
a topic of your choice. Your presentation should contain at least five slides. The instructor will be 
available to assist you with new features learned and answer further questions. 
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XII. Reference 
 

A. Hide Slide 
 
Hidden slides are excluded from an on-screen presentation. Slides can be hidden that are not 
pertinent to the presentation, but have valued information for your reference. This command can 
be done in the Normal or Slide Sorter View mode. 
 
 
1. Select the slide to be hidden. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Click on the Slide Show tab and then click on the Hide Slide button. 
 
3. Notice the Hidden Slide indicator on the left-hand side of the thumb print slide.  
 
4. To unhide slides, deselect the Hide Slide button. 
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B. Set Automatic Timing  
 
You can set timing for each of your slides in a presentation, so that you do not have to manually 
advance to the next slide by using the mouse button or arrow keys. 
 
 
 
 
 
 
 
 
1. Select the Slide Show ribbon and then click on the Rehearse Timing button to set slide  
 timing.  
 
2. A Recording window will appear, so that you can track the time on each slide while  
 rehearsing. 
 
 
 
 
 
 
 
 
3. Click on the Next       button on the Recording window when you are ready to advance to  
 the next slide. 
 
4. When you reach the end of the slide show the Microsoft PowerPoint window will appear. 
 
 
 
 
 
 
 
 
 
 
 
5.  Click on the Yes button to accept the timings or No button to try again. 
 
6. Once the Recording is set for your presentation, it will show on-screen automatically every 

time you launch your slide show. 
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7. If you choose to show your presentation without timing, select the Slide Show ribbon and  
 then deselect the Use Timings box. 
 
 
 

 
 

 

 

 

 
C. Working with an Image 
 

Images that appear on your document can be moved, resized, rotated, modified, or 
deleted. To change an image, click once on the image to select it. The following 
items will appear on the image: square handles on each of the four corners, square 
handles on each of the four sides, and a curved arrow on the top of the graphic. 

 
 

1. Move an image to another location on the document. Select the image and 
place the mouse pointer on the image. When the pointer changes to a double 
arrow cross, left-click the image and drag it to a new location on the document. 
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2. Resize an image to make it smaller or larger. Select the image and place the 
mouse pointer on one of the sizing handles (square). When the pointer 
changes to a double-sided directional arrow, left-click the image and drag it 
until the desired size is achieved. Use a corner circle handle for the best results 
in resizing an image. 

 

 

 

 

 

 

3. Rotate an image to a different angle. Select the image and place the mouse 
pointer on the curved arrow handle. When the pointer changes to a curved 
arrow, left-click the image and drag it in the direction you want to rotate the 
image.  
 
 
 
 
 
 

 
 
 
 

 
 

4. Modify an image by changing its color scheme, style, location, and cropping. 
Select the image and then the Picture Tools ribbon will appear. Click on the 
Format tab and your image can be modified by clicking on the appropriate 
button within the Adjust, Picture Styles, Arrange, and Size groups. 
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Note: When cropping an image, the mouse pointer becomes a cropping tool. Place the 
cropping tool on one of the resize handles of the image and drag towards the image to crop it. 

 
 
5. Delete an image from your slide. Select the image and then press the Delete key on the 

keyboard.  
 
 
 
Note: Placeholders can also be moved, resized, rotated, modified, or deleted in the same way as 
images. 
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